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R2023a

Version: 1.6

New Features

Bug Fixes

1



Apollo Import: Import scenes from Apollo file format
You can now import scenes from the Baidu Apollo® 3.0 and 5.0 XML formats into RoadRunner and
use the data to build scenes using the Scene Builder Tool. For more information, see “Build Scenes
Using Apollo HD Map Data”.

Building scenes using the Scene Builder Tool requires a RoadRunner Scene Builder license.

HD Map Route Creation: Create routes using CSV and KML files
You can now create routes automatically using CSV and KML files that contain latitude and longitude
coordinates. To create routes using these file formats, the RoadRunner scene must contain an
imported HD map. Previously, the Scene Builder Tool supported manual route creation. You can also
select these created routes to build a scene using the Scene Builder Tool. For more information, see
“Create Route and Build Scene Using HD Map Data”.

Building scenes using the Scene Builder Tool requires a RoadRunner Scene Builder license.

Programmatic RoadRunner HD Map: Import HD Map data
programmatically using MATLAB
Import HD map data into RoadRunner programmatically using the importScene method. This
MATLAB® function require an Automated Driving Toolbox™ license.

Coordinate Reference Systems: Read RoadRunner HD map using
readCRS function
Read RoadRunner HD map data using the readCRS function and specifying a roadrunnerHDMap
object. The function returns the coordinate reference system as a projcrs or a geojcrs object.

ASAM OpenCRG Support: Specify global mode for CRG data, create
synthetic CRG asset for selected road, and add rumble strips
You can now use the Road CRG Tool to combine CRG data and road data by specifying the global
mode. To specify this mode for your selected CRG data, in the Attributes pane, set the CRG Mode
attribute to OpenCRG Curve - Absolute Height (global) .

You can also use the Road CRG Tool to create a synthetic CRG asset for an entire road, or a selected
road span, directly from the Attributes pane. To create one, in the Attributes pane, click Create
Synthetic CRG Asset. The grid size of the created asset matches the size of the selected road or
road span. Therefore, you do not need to manually set the Grid Length and Grid Width attributes.

You can now add Rumble Strips elements to synthetic CRG assets, and then apply rumble strips to
the road.

R2023a
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R2022b

Version: 1.5

New Features

2



R2022b Update 5

Scene Builder Tool Options: Toggle creation of automatic junctions at
road overlaps
The Scene Builder Tool now provides the Enable Overlap Groups attribute. By default,
RoadRunner does not create automatic junctions at road overlaps when building imported HD map
data. Clear the Enable Overlap Groups attribute to create automatic junctions at road overlaps
when you build imported HD map data. For more information, see “Build Scene”.

Building scenes using the Scene Builder Tool requires a RoadRunner Scene Builder license.

R2022b
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R2022b Update 4

Project Roads: Project the height of roads using Maneuver Tool
You can use the Maneuver Tool in RoadRunner to project one or more maneuver roads down to the
height of an elevation map. This process samples the elevation data under the maneuver road and
performs a constrained fit of the maneuver road elevation to the trace of the elevation data.

ASAM OpenDRIVE Support: Import and export ASAM OpenDRIVE 1.7
data
Starting from R2022b Update 4, you can import ASAM OpenDRIVE® 1.7 data into RoadRunner and
export RoadRunner scenes to ASAM OpenDRIVE version 1.7. You can also import and export ASAM
OpenDRIVE 1.7 data using gRPC® APIs. For more information, see Export to ASAM OpenDRIVE and
Importing ASAM OpenDRIVE Files.

 R2022b Update 4
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R2022b Update 3

Programmatic RoadRunner HD Map API: Import HD Map data
programmatically using gRPC
Import HD map data into RoadRunner programmatically using the Import method of the gRPC API.
You need a RoadRunner license to load HD maps and a RoadRunner Scene Builder license to both
load and build HD maps into editable RoadRunner scenes. For more information, see
import_settings.proto.

Ubuntu 20.04 Support: Install RoadRunner on newly supported
version of Ubuntu
Starting from R2022b, you can install RoadRunner on Ubuntu® 20.04. For more information, see
RoadRunner System Requirements.

Import Subset of ASAM OpenDRIVE Data: Build selected sections of
ASAM OpenDRIVE files
Starting from R2022b, you can now import a subset of data in ASAM OpenDRIVE format. This
enables you to import and build small sections of very large ASAM OpenDRIVE files efficiently. For
more information, see Importing ASAM OpenDRIVE Files.

Export Highest LODs: gRPC supports exporting highest level of details
The gRPC export_settings.proto now supports the ability to export only the highest LODs
programmatically for these exporters: AutoCAD®, Filmbox, glTF™, OpenFlight, OpenSceneGraph,
USD, CARLA, Metamoto®, Unity®, Unreal®, Datasmith, and VTD.

R2022b
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R2022b General Release

Traffic Island Tool: Create freeform traffic islands in RoadRunner scene
The Traffic Island Tool enables you to create traffic islands in RoadRunner scenes, without using
road lanes and junction corners. Previously, creating traffic islands in a RoadRunner scene required
complex uses of road lanes and junction corners. Using the Traffic Island Tool, you can:

• Create traffic islands in a RoadRunner scene. Drag control points to modify the shape of the traffic
island.

• Modify the border of the traffic island by specifying attributes such as border style, border width,
and the material of the border.

• Adjust the height of each node on the traffic island.
• Add an inner shape to the traffic island. This figure shows a traffic island that has an inner

rounded oblong shape covered by grass.

The Traffic Island Tool supports more accurate importing and exporting of traffic islands to and
from the ASAM OpenDRIVE format. For more details, see Traffic Island Tool.

Scene Merge: Merging scenes for multiuser editing
You can now merge a scene directly from a scene file into a currently open scene, with the location of
the incoming scene automatically adjusted to match the current scene. Previously, merging two
RoadRunner scenes was a complicated process that involved these steps:

• Save one scene as a scene template
• Load the second scene
• Add the scene template to the loaded scene

 R2022b General Release
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The previous workflow required you to open multiple files. Also, RoadRunner lost the original
positional data when adding the scene template to the current scene. For more details on merging
two scenes using the new workflow, see Merge Multiple RoadRunner Scenes.

Programmatic Functions: Import custom data into RoadRunner using
MATLAB functions
Use MATLAB functions to convert custom data into the RoadRunner HD Map data model and import
your data into RoadRunner. Using these functions, you can:

• Create a new map, edit an existing map, and read and write from file
• Represent lanes, lane boundaries, lane markings, junctions, barriers, and signs
• Write the map to a RoadRunner HD Map (.rrhd) file.

These MATLAB functions require an Automated Driving Toolbox license. For a detailed workflow
demonstrating the use of these functions, consider reviewing Build Simple Roads Programatically
Using RoadRunner HD Map .

RoadRunner Console: Launch RoadRunner using terminal
In R2022b, you can launch RoadRunner in console mode allowing RoadRunner to be run from the
terminal in a non-graphical environment. This enables distributed workflows, for example, running
RoadRunner from a remote server, and empowers you to use RoadRunner at a much larger scale.

Like the interactive RoadRunner, RoadRunner Console can receive API commands sent from the
Programmatic Interface. You can write your own clients by compiling the proto files, using the
CmdRoadRunnerApi app, or the MATLAB functions for RoadRunner. For more details, see Control
RoadRunner Programmatically in Console Mode.

CARLA Plugin: Import RoadRunner maps to CARLA
Importing a RoadRunner scene to CARLA using the CARLA plugin enables you to import RoadRunner
map data. The CARLA plugin, RoadRunnerCarlaDatasmith handles the metadata after importing
the RoadRunner scene into CARLA. The metadata stores signalization and ASAM OpenDRIVE IDs.
The CARLA plugin reduces the import time for importing significantly large scenes to CARLA. For
more details, see Export to CARLA.

Scene Builder Options: Enable turn lanes and elevate bridges using
layer information when building SD Map data imported from
OpenStreetMap file (requires RoadRunner Scene Builder)
Enable Turn Lanes

• To include turn lanes when building roads from SD Map data, enable the Create Turn Lanes
option in the SD Map Builder dialog box.

Note The imported OpenStreetMap® file must contain turn lane information to view them in the
built roads.

R2022b
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Roads Built with Create Turn Lanes
Option Disabled

Roads Built with Create Turn Lanes
Option Enabled

Elevate Bridges Using Layer Information

• To elevate bridges and overpasses when building roads from SD Map data, enable the Elevate
Roads by Layer option in the SD Map Builder dialog box.

Note The imported OpenStreetMap file must contain layer information to elevate the bridges in
the built results.

Roads Built with Elevate Roads by Layer
Option Disabled

Roads Built with Elevate Roads by Layer
Option Enabled

Building scenes using the SD Map Viewer Tool requires a RoadRunner Scene Builder license.
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Improved Road Meshes: Create more accurate road meshes at road
junctions for imported SD Maps
RoadRunner now more accurately models road meshes imported from SD Maps.

Previously, roads built from SD Map data contained steep inclines in their road meshes at road
junctions.

R2022a R2022b

Asset Mapping Dialog Box: Customize asset mapping for HD Map
import
You can now configure the asset mapping used by RoadRunner project when importing HD Map data.
From the Assets menu, select Asset Mapping to open the Asset Mapping dialog box.

You can use the Asset Mapping dialog box to specify asset mapping for these map types:

• ASAM OpenDRIVE
• HERE HD - North America
• HERE HD - Western Europe
• TomTom HD

R2022b
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RoadRunner Asset Library Additions: Integration of scenes with
Unreal Engine and additional Japanese signs and stencils
The RoadRunner Asset Library Add-On now includes new signs and stencils for the Japanese asset
library. If you include the RoadRunner Asset Library assets in your project, these assets appear in
folders within the Library Browser. You can also integrate RoadRunner scenes with Unreal Engine®.

Additions to Japanese Asset Library

• For R2022b, additional signs and road stencils have been added to the Japanese asset library.
These signs are categorized into different folders in the Japan folder in the Signs folder in the
Library Browser. The signs are grouped into these categories: Auxiliary Signs,
Information Signs, Instruction Signs, Regulatory Signs and Warning Signs.
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New Japanese road stencils have been added to the Stencils folder in the Library Browser. The
added stencils are the ones most commonly used on expressways.

Integration of RoadRunner Scenes with Unreal Engine

• RoadRunner scenes can now be imported to Unreal. You can change the time of the day within the
scene to see how the scene will look during the day and night.
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RoadRunner HD Map Enhancements: Represent static objects in
RoadRunner HD Map data model
You can now represent static objects, such as props and road furniture, in the RoadRunner HD Map
data model. Use the hd_static_objects.proto protocol buffer (protobuf) schema file to convert
static objects from your custom data format into the RoadRunner HD Map format. For an example of
using the schema file to represent static objects, see Build Scenes from Custom Data Using
RoadRunner HD Map.
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Using this updated example, you can now represent signs, barriers, trees and buildings in a
RoadRunner HD Map data model and use the Scene Builder Tool to build a RoadRunner scene that
contains these elements. Use of the Scene Builder Tool requires a RoadRunner Scene Builder
license.
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Road Anchor Tool: Define road anchors to place scenarios within
scenes (requires RoadRunner Scenario)
The Road Anchor Tool enables you to define road anchors within a scene. Use these anchors as
relative points by which to define the positions of actors within a scenario. By moving these anchors
in a scenario, you can quickly relocate scenarios to areas within a scene. If the same anchor is
defined in more than one scene, then you can also relocate scenario to new scenes. Use of this tool
requires a RoadRunner Scenario license. For more details on working with anchors, see Scenario
Anchoring System (RoadRunner Scenario).

Programmatic Functions: Import and export scenes in RoadRunner
using MATLAB
Use MATLAB functions to control the RoadRunner UI programmatically. Using these functions, you
can:

• Launch RoadRunner application.
• Create, load, and save RoadRunner scenes and projects.
• Import ASAM OpenDRIVE files into scenes.
• Export scenes to one of the file formats that RoadRunner supports, such as ASAM OpenDRIVE,

USD, or Filmbox.
• Configure the export options to combine different file formats that RoadRunner supports.

These MATLAB functions require an Automated Driving Toolbox license. For details on using these
functions, see MATLAB Functions for Scenes.

Lane Heights: Modify inner and outer lane heights of sidewalks in
ASAM OpenDRIVE format
Previously, the lane height model in RoadRunner could not accurately reflect lane height data from
ASAM OpenDRIVE format. Now, you can adjust the inner and outer lane heights of sidewalks. Use the
Sidewalk Height Tool to edit the height of sidewalks. For more details, see Modify Inner and Outer
Heights of Sidewalk

Lane height nodes can be in either the linked or the unlinked state. Editing the height of a sidewalk
in the linked state changes both the inner and outer values of the lane height. By default, new height
nodes are in the linked state.
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You can modify the inner height and outer height for a sidewalk separately by unlinking the two
heights, as shown in this figure. In the Attributes pane, in the Lane Height Node section, click the

link icon  to unlink the inner and outer heights and edit their values individually.

Rotation Manipulators: Rotate objects interactively using mouse
Use the rotation manipulators in RoadRunner to seamlessly rotate a single object or a group of
objects interactively within a scene.

To rotate a single object, select the Prop Point Tool and then select a prop in the scene. From the
View menu, select Rotate.
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Three rings, representing rotation around the x-, y-, and z- axes, appear on the scene canvas around
the selected object. Drag the rings to make rotational adjustments to the object.

To rotate a group of objects, first select the Selection Tool. Click the scene canvas and drag to select
all the objects that you want to rotate.
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From the View menu, select Rotate.

Three rings, representing rotation around the x-, y-, and z- axes, appear on the scene canvas around
the selected object. Drag the rings to make rotational adjustments to the object.
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Export to Unreal using Datasmith Road
Exporting a RoadRunner scene to Unreal using Datasmith Road enables you to export ASAM
OpenDRIVE data along with the Datasmith file and also adds the metadata to Datasmith export. The
metadata stores signalization and ASAM OpenDRIVE IDs. The Datasmith Road export option reduces
the import time for significantly large scenes into Unreal. For more details, see Export to Unreal
Using Datasmith (.udatasmith) File

Camera Manipulation Improvements
• New enhancements to the camera controls ensure better pivot point control, quicker edits, and

scene manipulations with lesser frustration.
• Scroll wheel movement towards the mouse cursor is now unified between perspective and

orthographic cameras. Additionally, perspective camera also supports scrolling forward past the
pivot point for faster scene traversal.

• When nothing in the scene is selected, camera framing will frame all objects within the scene.
Finally, improvements have been made to smooth camera behavior when working remotely.

For more details, see Camera Control in RoadRunner.
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Upgrade RoadRunner Asset Library
You can upgrade the assets of a project created with a previous version of RoadRunner to the current
version. You must have a RoadRunner Asset Library license to upgrade the assets. Upgrading the
assets:

• Removes the replaced assets from the old location.
• Keeps customer assets (assets that are not in the Asset Library) intact.

For more details, see Create, Import, and Modify Assets.

Compatibility Considerations
If you created a project containing assets in R2021b or its previous versions, then the assets can be
upgraded in R2022a. For more details, see Create, Import, and Modify Assets.

RoadRunner Asset Library Additions: Populate scenes with additional
US, German, and Japanese traffic signs, and additional props and
stencils
The RoadRunner Asset Library Add-On now includes new signs for US, Germany, and Japan. If you
include the RoadRunner Asset Library assets in your project, these assets appear in folders within the
Library Browser.

Additional U.S., German, and Japanese Signs

Prior to R2022a, RoadRunner Asset Library contained signs for US, Germany, and Japan. For R2022a,
new additional signs have been included for these countries. The signs are now divided into sub
categories. Additional signs have also been added for roundabouts.

Props

The Props folder in the Library Browser includes additional buildings.
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Additional assets have been added to the Urban folder with the Props folder.
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Stencils

New road stencils have been added to the Stencils folder in the Library Browser for roundabouts.
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OpenStreetMap Roads: Build roads using map data imported from
OpenStreetMap file
You can now build roads by importing map data from an OpenStreetMap file with the .osm file
extension by using the SD Map Viewer Tool. For more details, see Build Roads Using
OpenStreetMap Data.
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ASAM OpenCRG Support: Create and export synthetic OpenCRG data
and visualize road surface data using different color gradients
You can now create synthetic OpenCRG assets to describe road surface properties, such as surface
noise, speed bumps, and potholes, by using the curved regular grid (CRG) format defined by ASAM
OpenCRG®.

Using the Road CRG Tool, you can assign a synthetic OpenCRG asset to a road segment in the scene
and visualize road surface variations. RoadRunner now supports several color gradients, including
Parula, HSV, and Jet, for visualizing road surface variations. For more information about how to
change the CRG color gradient, see Road CRG Tool.
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You can also export road surface data to an ASAM OpenCRG file. RoadRunner now supports the LRFI
and LDFI road data formats. For more information, see Export to ASAM OpenCRG.

RoadRunner HD Map Enhancements: Represent barriers and signs in
RoadRunner HD Map data model
You can now represent barriers and signs in the RoadRunner HD Map data model. Use these protocol
buffer (protobuf) schema files to convert these objects from your custom data format into
RoadRunner HD Map format.

Protobuf File Description
hd_barriers.proto Protobuf schema to represent barriers in

RoadRunner HD Map
hd_signs.proto Protobuf schema to represent signs in

RoadRunner HD Map

Asset Mapping Updates: Customize project-specific asset mapping for
HD map import
Starting from R2022a Update 1, RoadRunner provides these asset mapping files in the Project
folder of each RoadRunner project.

• HEREAssetData.xml — Asset mapping file for HERE HD Live Map data
• TomTomAssetData.xml — Asset mapping file for TomTom HD Map data

You can now modify these files and customize asset mapping for each project. Prior to R2022a Update
1, these files are located in the RoadRunner installation folder, and you must manually copy the
desired file to a Project folder to customize asset mapping for the corresponding project.

For more information on how to configure asset mapping files, see Configure Assets for Imported
HERE HD Live Map Data and Configure Assets for Imported TomTom HD Map Data.
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Programmatic API: Import and export scenes from the command line
or from languages such as Python or C++
Use the RoadRunner API service to control the RoadRunner UI programmatically. Using this API
service, you can:

• Create, load, and save RoadRunner scenes and projects.
• Import ASAM OpenDRIVE files into scenes.
• Export scenes to one of the file formats that RoadRunner supports, such as ASAM OpenDRIVE,

USD, or Filmbox.

To get started using this API service, see these examples:

• Convert RoadRunner Scenes Between Formats Programmatically
• Export Multiple RoadRunner Scenes Programmatically

This API service is built using the open-source gRPC framework. Using this framework, you can use
remote procedure call (RPC) methods to control RoadRunner in Python®, C++, or any other
programming language supported by gRPC. This figure shows a sample call from a Python client
application to load a RoadRunner scene.

For more details on the APIs, see Control RoadRunner Programmatically Using gRPC APIs.

The API service provides these RPC methods.

RPC Method Description
NewProject Create new RoadRunner project
LoadProject Load RoadRunner project
SaveProject Save RoadRunner project
NewScene Create new RoadRunner scene
LoadScene Load RoadRunner scene
SaveScene Save RoadRunner scene
Export Export RoadRunner scene
Import Import file into RoadRunner scene
Exit Exit RoadRunner application

Each RoadRunner installation includes a set of language-neutral protocol buffer (protobuf) files that
define the schema for the API service. This table shows the protobuf files for the service.
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Protobuf File Description
roadrunner_service.proto RoadRunner service protobuf schema
roadrunner_service_messages.proto RoadRunner service messages protobuf schema
import_settings.proto Import settings protobuf schema
export_settings.proto Export settings protobuf schema
geometry.proto Scene geometry protobuf schema

You can compile these protobuf files to generate the API code in various programming languages. For
more details, see Compile Protocol Buffers for RoadRunner APIs. Then, you can write language-
specific clients that call the generated API code. For sample clients, see these examples:

• Create Python Client for Controlling RoadRunner Programmatically
• Create C++ Client for Controlling RoadRunner Programmatically

Custom HD Map Formats: Import custom data into RoadRunner
Convert custom data into the RoadRunner HD Map data model and import your data into
RoadRunner. Each RoadRunner installation includes a set of language-neutral protocol buffer
(protobuf) files that define the schema for the RoadRunner HD Map data model. This table shows the
protobuf files for this data model.

Protobuf File Description
hd_map_header.proto RoadRunner HD Map header message
hd_map.proto RoadRunner HD Map message
hd_lanes.proto Lane representation messages for RoadRunner

HD Map
hd_lane_markings.proto Lane marking representation messages for

RoadRunner HD Map
hd_junctions.proto Junction representation messages for

RoadRunner HD Map
common_attributes.proto Common attributes for RoadRunner HD Map
geometry.proto Scene geometry protobuf schema

Use Python, C++, or any other programming language supported by protocol buffers to generate
RoadRunner HD Map files from custom data. For an example using C++, see Import Custom Data
Using RoadRunner HD Map.

Using the Scene Builder Tool, you can build a scene after importing a RoadRunner HD Map file. You
can then edit and export the scene to supported file formats, such as ASAM OpenDRIVE, USD, or
Filmbox. Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.
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RoadRunner Asset Library Additions: Populate scenes with additional
US and German traffic signs, Japanese traffic signs, and additional
props and buildings
The RoadRunner Asset Library Add-On now includes hundreds of new assets. If you include the
RoadRunner Asset Library assets in your project, these assets appear in folders within the Library
Browser.

As of R2021b Update 1, these assets are compatible for export to Unreal. For more details, see
“Compatibility Considerations” on page 4-8.

U.S. Signs

New US signs include emergency signs, school signs, and warning signs. These signs have been
organized into subfolders within the Signs folder of the Library Browser.

German and Japanese Signs

The Signs folder of the Library Browser includes new German traffic signs added to the Germany
subfolder and a new Japan subfolder for Japanese traffic signs.
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Extrusions

The Library Browser includes additional extrusion assets and their associated guardrail props and
textures.
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Props

The Library Browser includes additional environment and vegetation props. Additional levels of
detail have also been added to existing props.
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Buildings

The Library Browser includes additional buildings, such as homes in residential areas, a gas station,
a bus depot, and a school.
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Compatibility Considerations
If you created a project containing these assets in R2021b but before Update 1, then the assets are
not compatible for export to Unreal. To include the compatible assets in these projects, follow these
steps:

1 Install R2021b Update 1 or later.
2 Create a new project and include the RoadRunner Asset Library in that project.
3 Copy the assets and associated .rrmeta files from the new project into the existing project.

Note Replacing .rrmeta files overwrites any custom attributes you set, such as placement rules
for Prop Model Assets.

For more details on managing assets and projects, see RoadRunner Project and Scene System.

Assets from previous RoadRunner releases are already compatible for export to Unreal. All assets in
projects created in R2021b Update 1 or later are also compatible.
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OpenDRIVE 1.5 and ASAM OpenDRIVE 1.6 Support: Import and export
scenes using newly supported formats
You can now use RoadRunner to:

• Import scenes from OpenDRIVE® 1.5 and ASAM OpenDRIVE 1.6 files and convert them into
RoadRunner scenes.

• Export RoadRunner scenes to OpenDRIVE 1.5 and ASAM OpenDRIVE 1.6 files.

For information about the import and export capabilities, and limitations, see Importing ASAM
OpenDRIVE Files and Export to ASAM OpenDRIVE.

Scene Metadata: Add metadata to describe scene elements
RoadRunner now enables you to add metadata to describe the elements in a RoadRunner scene. You
can also use the metadata to set the value of ASAM OpenDRIVE attributes when you export the scene
to ASAM OpenDRIVE.

For details about how to add metadata, see Add Metadata to RoadRunner Scene Elements.

For an example of using metadata to set ASAM OpenDRIVE attributes, see Set ASAM OpenDRIVE
Attributes Using Metadata.

SD Map Import: Build roads from imported Zenrin Japan Map API 3.0
(Itsumo NAVI API 3.0) SD data
You can now import Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) 1 data and build roads using the
SD Map Viewer Tool.

This figure shows imported roads in the SD format.

1 To gain access to the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) service and get the required credentials (a client
ID and secret key), you must enter into a separate agreement with ZENRIN DataCom CO., LTD.

 R2022b General Release

4-9

https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/importing-opendrive-files.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/importing-opendrive-files.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/export-to-opendrive.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/add-metadata-to-roadrunner-scene-elements.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/set-opendrive-attributes-using-metadata.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ug/set-opendrive-attributes-using-metadata.html
https://www.mathworks.com/help/releases/R2021b/roadrunner/ref/scenebuildertool.html
https://support.e-map.ne.jp/manuals/v3/


This figure shows a scene built from this imported data.
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This figure shows a close-up of the built roads. The scene includes overpasses where the elevation
information is available in the imported Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) SD data.
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For an example of building roads by using Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) data, see
Build Roads by Using Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) Data.

TomTom HD Map Import: Build scenes from imported TomTom HD maps
(requires RoadRunner Scene Builder)
RoadRunner Scene Builder supports a pair of TomTom HD Map data formats: Avro (Format
Specification Version 1.2.0.0 and Schema Version 1.1) and GeoPackage. Use RoadRunner Scene
Builder to import road networks, road markings, barriers, and traffic signs from TomTom HD Map
data.

This figure shows a preview of the imported TomTom data.
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This figure shows a scene built from that data.
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This figure shows a close-up of the built data. The scene includes overpasses, and scene objects such
as guardrails.
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For an example of building a scene from TomTom data, see Build Scenes Using TomTom HD Map
Data.

You can also customize which assets RoadRunner uses to display imported data. For more details, see
Configure Assets for Imported TomTom HD Map Data.

Edit the imported roads using RoadRunner and export the results to supported simulation and game
engine formats.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

ASAM OpenCRG Support: Import and export road surface data using
ASAM OpenCRG files
You can now import road surface data from ASAM OpenCRG V1.2.0 file into a RoadRunner scene. Use
the Road CRG Tool to assign the specified data to a road segment in the scene and visualize road
surface variations using a colormap. For more details, see Importing ASAM OpenCRG Files.

You can also link and export road surface data using an ASAM OpenDRIVE file. For more details, see
Export to ASAM OpenCRG.

HD Map Route Creation and Build: Build routes from TomTom HD Map
and HERE HD Live Map data (requires RoadRunner Scene Builder)
The Scene Builder Tool now allows you to create routes, and select the roads and objects around
those routes to build them. For more details on creating routes for HD Map data, see Create Routes.
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Including the selective roads and objects along the created routes reduces the build time. Previously,
the Scene Builder Tool supported only roads and scene objects, with no option to define the routes
to build. For more details on scene building options, see Build Scenes Using TomTom HD Map Data
and Build Scenes Using HERE HD Live Map Data.

Building scenes using the Scene Builder Tool requires a RoadRunner Scene Builder license.

STL Import and Export: Import and export scenes using STL file format
Now you can import STL files into RoadRunner to create assets or scenes. You can also export road
scenes to the binary STL format. For more details, see Export to STL.

Selection Tool: Select roads and props in a scene as a group
Use the Selection Tool to select roads and props in a scene as a group.

Once you have selected an object, you can:

• Move the object group using the translation manipulators.
• Duplicate the object group using copy (Ctrl+C) and paste (Ctrl+V).
• Save the selected object group as a scene asset.

Scene Templates: Create scene asset templates from existing and
selected scenes
Create scene assets, which are collections of roads, intersections, props, and other 3D objects, and
add them to the Library Browser. Add scene assets to a project to quickly build up a complex
environments.
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From the Assets menu, select Assets > New > Scene Template to add the current scene, or
selected objects in the scene, as a template asset into a folder in the Library Browser of the current
project.

Translation Manipulators: Move objects precisely in x-, y-, and z-
directions
From the Tools menu, select Translate to show translation manipulators for selected objects. Use
these manipulators to precisely translate objects in a selected direction.

Lane Tool: Reverse lane travel direction
Use the Lane Tool to reverse the travel direction of the selected lanes.
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You can select a lane or lanes and change the travel direction from forward to backward or backward
to forward. This option does not affect bidirectional and undirected lanes.
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Custom Level of Detail: Customize level of detail in exported scenes to
improve simulation performance
You can now customize the level of detail (LOD) used to render scenes that you export to simulators.
To access LOD settings, from the Tools menu, select LOD Settings. Using these settings, you can
reduce the level of detail at distances away from the simulator camera, where the reduction in scene
quality is acceptable. These modifications can improve simulation performance substantially. Export
of LODs is supported for FBX® files only. For more information on customizing levels of detail, see
Customize Levels of Detail in Exported Scenes. Examples of the changes you can make at these
distances away from the camera include:

• Reduce the amount of triangulation by modifying settings such as the positional tolerance. These
images show varying amounts of triangulation at different LODs.

Triangulation: High Level of Detail Triangulation: Low Level of Detail

• Flatten tiles containing roads and ground terrain into single texture images by selecting the
Overhead Tile Rendering option. These images show the difference in tile rendering at varying
LODs.

Tile Rendering Disabled Tile Rendering Enabled

• Combine, or pack, props in a tile into a single prop model by selecting the Pack Props option.
Prop packing reduces the number of textures needed to render props, at the expense of visual
quality.

R2021a

5-2

https://www.mathworks.com/help/releases/R2021a/roadrunner/ug/customize-levels-of-detail-in-exported-scenes.html


Prop Packing Disabled Prop Packing Enabled

To verify that scene performance improves as you reduce the level of detail, you can visualize how
many draw calls the target simulators need to make to render the props. To view the draw calls, on
the View menu, select Draw Calls. These images show the difference in draw calls for a scene with
varying levels of detail. Each color represents a separate draw call.

Scene with High Number of Draw Calls Scene with Low Number of Draw Calls

Road Superelevation Tool: Manipulate banking angle along roads
Use the Road Superelevation Tool to control the superelevation (slope and banking angle) along
the entire length of a road.
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RoadRunner also supports the import of superelevation data from HERE HD Live Map by using the
Scene Builder Tool (requires RoadRunner Scene Builder).

Custom Export Configurations: Specify customized combinations of
file formats and scene data to export
In RoadRunner projects, you can now specify an XML file that enables the exporting of custom
formats. For example, you can specify a combination of file formats not available in the File menu,
under Export. You can also customize the type of data to export for each file format. For more details,
see Export Custom Formats.

Quality Checks: Identify additional issues to fix in your scenes using
built-in validation rules (requires RoadRunner Scene Builder)
The Scene Builder Tool now checks for quality issues in built scenes, including substantial changes
in elevation and lane boundaries that intersect with each other. These issues are displayed in the
Output window after you build the scene. Use these checks to identify whether these issues are
present in the source data from which you are importing.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

HERE Localization Data: Import signs, poles, and barriers from HERE
HD Live Map (requires RoadRunner Scene Builder)
The Scene Builder Tool can now import signs, poles, and barriers from the HERE HD Live Map
service. Previously, the tool imported only road networks.
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You can use this scene data as landmarks when simulating localization algorithms. For an example of
building a scene that contains this data, see Build Scenes by Using HERE HD Live Map Data.

You can also customize what assets RoadRunner uses to display imported data. For more details, see
Configure Assets to Use for Imported HERE HD Live Map Data.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

Improved Cross-Sections: Create more accurate road cross-sections
that are compatible with OpenDRIVE importing and exporting
RoadRunner now models road cross-sections more accurately. The increased accuracy enables you to
import roads with complex cross-sections from OpenDRIVE. To manipulate these cross-sections, use
the Cross Section Tool. You can then export these roads back to OpenDRIVE or to another
simulator.

Sidewalk Height Tool: Modify sidewalk and curb heights
Use the Sidewalk Height Tool to modify the heights of sidewalks and curbs along a road. You can
modify sidewalk heights along the entire length of a road or at arbitrary points along a road.
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Light Source Parameters: Import and export parameters for
controlling traffic lights and streetlights
When you import FBX file assets containing light sources, RoadRunner now imports the parameters
that control the lighting effects. RoadRunner also exports this light data, enabling you to control
lighting effects such as brightness or color in the exported scenes. For more details on exporting FBX
files, see Export to FBX.

R2021a

5-6

https://www.mathworks.com/help/releases/R2021a/roadrunner/ug/export-to-fbx.html


R2020b

Version: 1.1

New Features

Bug Fixes

6



RoadRunner Scene Builder: Automatically generate 3D road models
from HD maps
Use RoadRunner Scene Builder to import roads from HERE HD Live Map data.

Edit the imported roads using RoadRunner and export the results to supported simulation and game
engine formats.

Road Speed Limits Tool: Set varying speed limits along roads
Use the Road Speed Limits Tool to set varying speed limits along sections of a road. When you export
your scene to a simulator, you can use these values to test whether vehicles drive the set speed limits.

Bridge Span Creation: Fix bridge spans formed on elevated roads
In the Road Construction Tool, use the Auto Assign Bridges button to form bridge spans along
elevated roads. Use this tool to fix bridges in scenes where one road is elevated above another road.

Project Props to Terrain: Align prop curves with the surface terrain
In the Prop Curve Tool, use the Project to Terrain option to align props and extrusions with the
surface terrain rather than with the curve that you create. When you create prop curves, this option
is selected by default.
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RoadRunner Editor: Interactive editor to model roads and 3D
environments
For details, see User Interface.

Intersections: Design complex intersections featuring merges, splits,
and traffic circles
For details, see Road Plan Tool.

Surface Damage: Add detailed road surfaces with lane markings,
stencils, and custom graphics
For details, see Surface Tool.

RoadRunner Asset Library: Library of prebuilt professionally created
assets
For details, see RoadRunner Asset Library.

Customize Road Signs: Combine text and graphics to build custom
signs
For details, see Sign Tool.

Traffic Signals: Edit signal phases and timing with the integrated
signal timeline and interactive controls
For details, see Signal Tool.

GIS Import: Import aerial imagery, elevation data, lidar point clouds,
and road maps to accurately represent physical locations in
RoadRunner
For details, see GIS Data Resources for RoadRunner.

OpenDRIVE Import and Export: Import and export road networks using
OpenDRIVE format
For details, see Importing OpenDRIVE Files and Exporting to OpenDRIVE.

Export to Apollo
RoadRunner can export road scenes to Baidu Apollo formats. You can export to Apollo 3.0 and 5.0
XML formats and Apollo 5.0 binary format.
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For details, see Exporting to Apollo.

Export to Universal Scene Description (USD)
You can now export road scenes to USD. For details, see Exporting to USD.

Export for Metamoto simulations
You can now export road scenes for use in Metamoto simulations. For details, see Exporting to
Metamoto.

Import from OpenDRIVE improved
Importing OpenDRIVE files is now faster.

Additionally, you can now import:

• Larger OpenDRIVE files
• Road types
• Speed limits
• Multiple road segments as one continuous lane
• Nonnumeric IDs
• Object types

For details, see Importing OpenDRIVE Files.

Export to OpenDRIVE improved
When exporting to OpenDRIVE, you can now export:

• Speed limits
• laneSection entries for the same RoadRunner road
• Object types
• U-turns

For details, see Exporting to OpenDRIVE.

Improved support for GIS assets
RoadRunner can now import geographic information system (GIS) data with earth-centric projection
information.

For GIS import information, see Importing GIS Data in RoadRunner.

Vector-type scaling
Dragging the Scale label on vector types scales all axes uniformly.
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